Thực hành flash bài 1
 (Thứ Năm, 29/05/2008-9:22 AM) [image: image1.jpg]


Đây là một file flash với một ảnh nền chạy mãi mãi, không có điểm dừng. Tưởng chừng bức ảnh sẽ rất dài nhưng thực ra nó chỉ là một ảnh với kích thước bằng đúng cái flash này 

Thủ thuật rất đơn giản là làm cho điểm đầu và điểm cuối của hình thật khớp với nhau.

Bài viết này sẽ trình bày cụ thể cho bạn cách làm này bằng Photoshop và Flash.

Đầu tiên bạn cần chọn một tấm hình thật ưng ý, như hình ảnh phong cảnh với kích thước 420x120 pixel này chẳng hạn.
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Mở hình bằng Adobe Photoshop, bạn copy Layer hình thêm một Layer nữa. Tôi đặt tên là Layer 1 và Layer 2.
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Dùng công cụ Move (V) di chuyển Layer 1 đi một đoạn khá lớn, tương tự ta cũng move Layer 2 đi một đoạn sao cho điểm cuối của hình ảnh trên Layer 1 sát mép với điểm đầu của hình ảnh trên Layer 2.
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Nhiệm vụ của bạn giờ đây là làm sao cho 2 mép này hòa lẫn vào nhau. Có rất nhiều cách, ở đây tôi sử dụng công cụ Clone Stamp (S) để tô hình này chồng lên hình kia, tất nhiên đòi hỏi bạn phải có kỹ thuật Photoshop một chút xíu. Nhấn đè phím Alt để lấy mẫu và bắt đầu tô, chọn Opacity là 20% là vừa.
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Cuối cùng ta có ảnh kết quả như sau:
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Vậy là xong với Photoshop, bây giờ mở Macromedia Flash ra, tạo file mới có kích thước 420x120 (bằng với kích thước hình), nếu cần kích thước khác thì vào Photoshop chỉnh sửa lại kích thước ảnh để cho đẹp.

Vào menu File.Import (Ctrl+R) để import hình cuối cùng ở trên vào. Chọn hình đó, copy và paste trên cùng Layer. Ghép 2 mảnh lại liên tục với nhau, cạnh cuối hình này sát mép cạnh đầu hình kia, nhất là phải thẳng hàng với nhau (nên dùng panel Align (Ctrl+K) và Info (Ctrl+I) để canh chỉnh và xác định tọa độ cho chính xác.
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Canh chỉnh xong, chọn cả hai hình, nhấn F8 (Convert to Symbol) để tạo đối tượng là movieclip, nhớ chọn tâm của đối tượng là góc trái trên, điểm (0,0). Canh movieclip này vào góc (0,0), right-click movieclip và hcọn Action, dán đoạn code này lên đó (trên movieclip chứ không phải trên Timeline nhé)

CODE

onClipEvent (load) {
// Định bước nhảy (số pixel), số càng to chạy càng lẹ, số âm chạy từ phải qua trái, số dương chạy ngược lại
var stepX=-2;
var maxX=420; // Độ rộng của movieclip, có thể viết var maxX=this._width/2;
}
onClipEvent (enterFrame) {
vitriX=this._x+stepX;
if (vitriX>0) vitriX-=maxX;
if (vitriX<-maxX) vitriX+=maxX;
this._x=vitriX;
}

Tạo thêm Layer làm mặt nạ 420x120 pixel để che toàn bộ movieclip này nhé. Rồi đó, bây giờ nhấn Ctrl+Enter để test xem nhé.

Đối với những ai không biết AS thì có thể dùng movieclip này để tạo motiontween, keyframe đầu movieclip nằm ở vị trí x=-420, keyframe 2 movieclip nằm ở vị trí x=0.

Xong ấn Ctrl + Enter


Nguồn vnfx.com

Thực hành đơn giản với Flash 
Nguồn : http://www.vuontinhnhan.net/forum/showthread.php?t=38648


Tạo file flash dễ dàng
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Định dạng file flash trình chiếu hết sức thông dụng, và có nhiều công cụ, tiện ích giúp chúng ta tạo file flash. Trong đó, một trong những cách thức dễ dàng nhất là sử dụng phần mềm miễn phí Flash Slide Show Maker 2.3 (FSSM). Chương trình có dung lượng 5,09 MB, tải về từ địa chỉ http://flash.dvd-photo-slideshow.com. 
Sau khi cài đặt, kích hoạt chương trình, tiến hành tạo file flash theo trình tự sau: 

- Bấm nút Create New Project. 

-Bấm nút Add Photo để nạp hình ảnh muốn tạo trong file flash, chỉ đến vị trí chứa hình. Sau khi chọn xong các hình bấm Next để qua bước sau. 

- Khung Flash Options quy định các tùy chọn cho file như tiêu đề, độ rộng, chiều cao, màu nền... 

- Khung Theme là các mẫu cho người dùng tùy chọn. Chọn cách hiển thị tại Decorate the photo with. 

- Nạp nhạc cho file flash bằng cách bấm nút Add, chỉ đến vị trí file nhạc làm nền. FSSM hỗ trợ các định dạng wav, mp3, wma. Có thể bấm nút Play để nghe trước bản nhạc. Quy định xong bấm Next. 

- Cửa sổ kế tiếp với Output Options, chấp nhận theo mặc định là Create Flash File Only. Bấm Next. 

- Đặt tên cho file và chỉ vị trí lưu file. Sẽ có hai file được tạo thành là swf và html. 

- Bấm Publish Now để hoàn tất. 

- File dạng html có thể tự hoạt động, file swf cần có một phần mềm để hoạt động. [/font]

Làm chữ karaoke chuyển động theo lời bài hát

1. tạo 1 file mới bằng cách nhấn Ctrl+N.
2. Vào Insert > New Symbol (Ctrl+F8), đặt tên cho symbol là Chữ Karaoke, Behavior là Graphic.
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3. Gõ chữ cần thể hiện. Ví dụ Cuộc sống tươi đẹp
4. Tạo mới 1 symbol khác, chế độ behavior là Movie clip. có tên chuyển dộng
5. Kích chuột vào layer 1 và chọn insert layer để tạo mới 1 layer. Các bạn hãy tạo ra 3 cái, sau đó đặt tên cho 3 layer như hình.
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6. Kích chuột vào Frame 3o trên layer chữ kara 1 sau đó nhấn F5. Lập lại việc này với 2 layer còn lại.
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7. Kích chuột vào Frame1 trên layer Chữ Kara 2, sau đó nhấn Ctrl+L để mở thư viện Symbol. Sau đó kéo Symbol có tên Chữ Karaoke ra tâm của màn hình làm việc.
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8. Tiếp tục kích chuột vào Frame1 của layer chữ Kara1, sau đó kéo chữ cuộc sống tươi đẹp ra đè lên chữ cuộc sống tươi đẹp kia, kéo làm sao cho chúng nằm khít lên nhau.
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9. Kích chuột vào Frame1 của layer mặt nạ, sau đó nhấn R để dùng công cụ Rectangle Tool để vẽ 1 hình chữ nhật như hình.
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10. kéo nó nằm phía trước chữ cuộc sống tươi đẹp.
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	Hình bên dưới đã được thu nhỏ, bấm vào đây để xem kích thước thật: ngang*cao là 689x59.
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11. Kích chuột vào Frame30 của layer mặt nạ và nhấn F6. 
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12. Tiếp tục làm như hưỡng dẫn của hình.
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13.
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14. Kích chuột phải vào layer chữ Kara 2 và chọn Mask.
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15. Khi đó layer Chữ Kara 2 và layer mặt nạ sẽ bị khóa.
16. Quay về sân khấu (Scene1) sau đó kéo symbol có tên là chuyển động ra ngoài sân khấu. Sau đó nhấn Ctrl+Enter để xem kết quả.
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17. Muốn save lại thì vào File > Export > Export movie.
ĐÂY LÀ KẾT QUẢ

[flash]http://www.macromedia.com/go/getflashplayer align=baseline src=/Uploaded/hieuthien/30-11/lamchu.swf[/flash]

Làm đối tượng mờ ảo

1. Mở Photoshop ra và gõ vào đó bất kỳ thứ gì hoặc một hình ảnh bất kỳ. Sau đó save hình này lại với tên là GỐC
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2. Sau đó vào Filter > Blur > Gaussian Blur, giá trị là 3 pixel, sau đó save nó lại với tên là MỜ.
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3. Vào Flash Thiết lập kích thước cho cái file hình mà bạn vừa save từ photoshop. Ở đây bức hình của tôi có kích thước là 346x90.
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4. Tạo ra 2 layer và đặt tên cho nó là Hình mờ và Hình gốc, xắp xếp chúng như hình. 
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5. Vào File > Import > Import to Library, sau đó đưa 2 bức hình mà bạn vừa save vào thư viện của Flash. Nhấn Ctrl+L để hiện thư viện ra.
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6. Trên Frame 1 của layer HÌNH GỐC, các bạn kéo image GỐC trong Library ra sân khấu.
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7. Trên Frame 1 của layer Hình MỜ, các bạn kéo Image MỜ từ thư viện ra sân khấu.
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8. Kích chuột phải lên Image Mờ và chọn Convert to Symbol. 
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9. Trong Behavier các bạn chọn Graphic.
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10. Sau đó tạo ra tiến trình thời gian như hình. 
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11. Frame 1 của layer HÌNH MỜ các bạn chọn alpha khoảng 2% , Frame 15 khoảng 95%, fRAME 30 LÀ 8% - NHÌN HÌNH MINH HOẠ ĐỂ LỰA CHỌN CHẾ ĐỘ. 
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	Hình bên dưới đã được thu nhỏ, bấm vào đây để xem kích thước thật: ngang*cao là 693x598.
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12. Nhấn Ctrl+Enter để xem kết quả. 

Step 9

Trở về cửa sổ làm việc chính băng cách nhấn vào chữ Scene 1 , tạo một layer mới và đặt tên là lighting.
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Step 10

Khóa layer 1 lại, chọn layer lighting, chọn công cụ the Pencil (Y), màu tô Stroke chọn màu trắng , Màu tô Fill chọn màu trắng nhưng chọn Alpha là 50% (hình A) . Trong Option chọn ink (hình B), mở bảng Properties Panel (Ctrl+F3), giá trị Stroke Height chọn 3px và giá trị Stroke Style chọn Solid. Xem hình C
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Hình A
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HÌnh B
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Hình C

Step 11

Sau đó rê chuột vẽ một tia sét trên nền của tấm hình, xem hình
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Step 12

Nhấn F8 và convert nó về MovieClip , đặt tên là line_mc
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Step 13

Kích chuột phải lên hình tia sét và chọn Edit in Place.

Step 14

Kích vào frame 2 và nhấn F6 (Keyframe). sau đó nhấn nút delete để xóa hình tia sét trên frame thứ 2 , chọn công cụ Pencil (Y), và vẽ lại một tia sét khác với tư thế khác (xem hình E)
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(Hình D)
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(Hình E)

Step 15

Lập lại việc này trên 7 KeyFrame (Thực hiện thao tác copy và paste). Nghĩa là ở Frame thứ 1 3 5 7 thì sẽ cho tia sét ở hình D xuất hiện, còn ở Frame thứ 2 4 6 thì cho tia sét ở hình E xuất hiện
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Sau đó nhấn Enter để kiểm tra sét đánh

Step 16

Click lên Frame thứ 60 và nhấn F5. Sau đó click lên Frame thứ 8 và nhấn F7 để xóa đi các hình ảnh có trên Frame 8 đến Frame thứ 60
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Step 17

Trở về màn làm việc chính (Scene 1), Chọn "lighting" (Chọn tia sét), Mở bảng Filters. sau đó kích vào Icon hình dấu + và chọn Glow. 
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Step 18

Sau đó thiết lập lại tham số của giá trị Glow như hình dưới (mục đích làm tia sét lóe sáng)
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Kiểm tra phim nào (Ctrl+Enter).

Macromedia Flash - Thiết kế flash tải chương trình

Bước 1 

Mở Flash và tạo một file mới với kích thước 200x100px. Chọn màu nền là màu trắng và thiết lập Frame rate là 24, sau đó kích OK. 

[image: image45.jpg]Tie:

Description

Dimensions

Match:
Backaround color
Frame rate

Ruler units:

[200p | ity x  [100px | theight)

Oprinter @ Contents O Default

e





Bước 2 

Sử dụng công cụ Oval Tool (O). Trong phần Colors của panel Tool, bỏ màu Stroke bằng cách kích vào biểu tượng chiếc bút nhỏ, sau đó chọn ô nhỏ có đường gạch chéo màu đỏ. Trong phần Fill color chọn màu #F80000 và vẽ 3 hình tròn như hình sau: 
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Bước 3 

Sau khi vẽ xong 3 hình tròn, sử dụng công cụ Line Tool (N). Chọn màu nét vẽ là #F80000 và phần Solid là chọn nét vẽ với độ dày là 0.5. 
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Sau đó vẽ các hình sau 
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Bước 4 

Sử dụng công cụ Paint Bucket Tool (K), tại phần Fill color chọn màu #F80000 và đổ màu cho hình đã tạo ở bước trước. 
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Bước 5 

Nhấn phím Ctrl + A (Chọn toàn bộ) và sau đó nhấn phím F8 (Convert to Symbol) đê chuyển toàn bộ hình vẽ trên sang Movie Clip Symbol. Xem hình dưới. 

[image: image50.jpg]Cony

to Symbol

Type: OFiiedly  Regsnaton 238
Obuton
Oarsphic





Bước 6 

Kích đúp vào movie clip bạn sẽ thấy phần bên trong của movie. 
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Bước 7 

Kích đúp lên layer 1 để đổi tên. Kích vào frame 100 và nhấn phím F5. Sau đó tạo một layer mới ở trên layer của hình và đặt tên là mask. 

Bước 8 

Chọn layer mask, dùng công cụ Rectangle Tool (R). Trong phần Colors của panel Tool, bỏ màu của Stroke bằng cách kích vào biểu tượng chiếc bút nhỏ và sau đó vẽ một hình chữ nhật như hình dưới. 
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Bước 9 

Kích lên frame 100 và nhấn phím F6. Sau đó dùng chuột hoặc phím mũi tên để kéo hình chữ nhật đè lên hình đã vẽ ban đầu. 
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Bước 10 

Kích chuột phải vào bất cứ vị trí nào trên vùng màu xám giữa hai keyframe và chọn Create Motion Tween từ menu xuất hiện. 
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Bước 11 

Chọn layer mask và chuyển nó sang dạng mặt nạ bằng cách kích chuột phải vào layer đó và chọn Mask. 
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Bước 12 

Tạo một layer mới ở phía trên layer mask và đặt tên là percent (phần trăm) 

Bước 13 

Chọn layer percent và kích chọn công cụ Text tool (T). Vào Properties Panel (Ctrl + F3) ở phía dưới và chọn những tuỳ chọn như sau: 

a) Chọn Dynamic Text 

b) Chọn font Lucida Sans 

c) Chọn cỡ chữ 11 và kiểu chữ đậm. 

d) Chọn màu là #323232 

e) Chọn Anti-alias for readability 

f) Tại trường Var: nhập percen101 
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Sau đó nhập một vào một giá trị 99% ở bên dưới hình. 
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Bước 14 

Trở lại scene chính (Scene1) 
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Bước 15 

Chọn công cụ Selection Tool (V), kích một lần lên preloader để chọn nó và mở phần Action Script Panel (F9). Sau đó đưa vào đoạn mã sau: 

onClipEvent (load) { 
total = _root.getBytesTotal(); 
} 

onClipEvent (enterFrame) { 
loaded = _root.getBytesLoaded(); 
percent = int(loaded/total*100); 
percen101 = ""+percent+"%"; 
gotoAndStop(percent); 
if (loaded == total) { 
_root.gotoAndPlay(2); 
} 
} 

Vậy là chúng ta đã hoàn thành phần preloader. Để xem nó hoạt động như thế nào, kích vào frame đầu tiên và lại sử dụng công cụ Action Script Panel để đưa mã sau vào: 

stop (); 

Sau đó tạo một layer mới ở trên layer preloader, kích lên frame thứ hai và nhấn phím F6. Sau đó, Import, đặt vị trí, tạo hiệu ứng, ảnh, movie. Và kích một lần nữa vào frame thứ hai, nhập lệnh stop(); vào phần Action panel. Hãy thử chạy file đã tạo hoặc download file mẫu tại đây. 

Macromedia Flash - Đối tượng con trỏ động

Bước 1 

Tạo một file Flash mới và thiết lập Width là 350, Height là 200px. Frame rate set là 33fps 

Bước 2 

Click đúp vào layer1 và đổi tên thành Background. Sau đó chèn thêm một layer mới với tên là Active object. 

Bước 3 

Sử dụng các công cụ đơn giản của Flash để vẽ một đối tượng theo ý bạn. Ví dụ, tôi có một hình vẽ giống hình con trỏ như dưới đây 

[image: image60.jpg]



Bước 4 

Chọn “đối tượng vừa vẽ” và nhấn phím F8 (Convert to Symbol) để chuyển đổi nó sang dạng Movie Clip. 
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Bước 5 

Sau khi chuyển đổi xong, mở Properties (Ctrl + F3) và tại dòngnhập vào object. 
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Bước 6 
Sau đó, chọn frame đầu tiên của layer Active object, trong của sổ Action Script (F9) đưa vào đoạn script sau: 

startDrag(object, true); 

Bước 7 

Click đúp vào “đối tượng” để vào chỉnh sửa nội dung bên trong 

Bước 8 

Chọn “đối tượng” nhấn phím F8 để chuyển đổi sang Movie Clip 
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Bước 9 

Click vào frame 15 của layer1 và nhấn phím F5. Sau đó chọn frame đầu tiên của layer1 và click chuột phải chọn Copy Frames. 

Bước 10 

Thêm một layer mới (layer2), chọn frame đầu tiên, click chuột phải và chọn Paste Frames. 
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Bước 11 

Sau đó, click lên frame 15 của layer2 và nhấn phím F6 (Keyframe). 

Bước 12 

Sử dụng phím mũi tên lên xuống để đặt đối tượng trên một vị trí mà bạn muốn nó xuất hiện 
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Bước 13 

Trong khi “đối tượng” của bạn được chọn, hãy mở Properties (Ctrl + F3) và dưới phần Color chọn Alpha và thiết lập là 0%. 

Bước 14 

Trở lại frame đầu tiên của layer2, mở Properties, tại phần Tween chọn Motion. 
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Việc cuối cùng là nhấn Ctrl + Enter. Download file nguồn. 

Macromedia Flash - Di chuyển đối tượng

Bước 1

Tạo một file Flash mới, vào Modify > Document (Ctrl + J) và thiết lập Width là 350px, Height là 250px 

Bước 2 

Click đúp vào layer 1 và đổi tên thành Background. Sau đó chèn thêm một layer mới với tên là Object. 

Bước 3 

Chọn công cụ Rectangle Tool (R), và vẽ một hình chữ nhật để trình diễn “Object” 
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Bước 4 

Khi Object đã được chọn, bạn hãy nhấn phím F8 (Convert to Symbol) để chuyển đổi nó sang dạng Movie Clip. 
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Bước 5 

Click đúp vào đối tượng Movie Clip vừa tạo hoặc click chuột phải và chọn Edit in Place. 

Bước 6 

Sau đó bạn nhấn phím F8 và convert nó sang biểu tượng Button 
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Bước 7 

Lựa chọn đối tượng Object, mở Action Script (F9) và đưa vào đó đoạn script sau: 

on (press) { 
swapDepths(2 ); 
_root.cursor.swapDepths(3); 
startDrag(""); 
} 

on (release) { 
stopDrag(); 
} 

Bước 8 

Trở lại Scene chính (Scene 1), click vào frame đầu tiên của layer Object và mở Action Script (F9), đưa vào đó dòng sau: 

help = false; 

Bước 9 

Nhân đôi layer Object lên thành vài bản tuỳ ý bạn. 

Bước 10 

Thêm một layer mới và đặt tên là Cursor. Sau đó chọn Text Tool (T), và gõ vào đó dòng chữ “Move it” (hoặc nội dung nào khác) 
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Bước 11 

Chọn layer text (Cursor) và nhấn phím F8 để chuyển đổi sang dạng Movie Clip. 
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Bước 12 

Sau đó, mở Properties và nhập vào ô <Instance Name> chữ cursor. 
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Bước 13 

Tiếp theo bạn lại chọn layer cursor, mở Action Script (F9) và dưa vào đoạn script sau: 

onClipEvent (load) { 
} 
onClipEvent (mouseMove) { 
xm = getProperty (_root, _xmouse ); 
ym = getProperty (_root, _ymouse ); 
setProperty("_root.cursor", _x, xm); 
setProperty("_root.cursor", _y, ym); 
} 

onClipEvent (mouseDown) { 
with (_root.cursor) { 
gotoAndStop("clench"); 
} 
} 

onClipEvent (mouseUp) { 
with (_root.cursor) { 
gotoAndStop("open"); 
} 
} 

Vậy là đã xong, bạn có muốn xem sản phẩm sẵn có không?

Thiết kế Banner flash hoàn thiện

Bước 1 
Mở một file flash mới, vào Modify > Document và thiết lập các thuộc tính Width: 430px; Height: 180px; Frame rate set: 22fps 

Bước 2 
Tìm 3 bức ảnh để đưa lên banner và thiết lập kích thước của ảnh tương tự như nền (430x180px). Bạn có thể sử dụng Photoshop hay bất cứ chương trình đồ hoạ nào khác để chỉnh sửa 

Bước 3 
Click đúp vào layer1 và đổi tên thành picture1 

Bước 4 
Vào File > Import > Import to Stage (Ctrl + R) và Import bức tranh đầu tiên. Sau đó sử dụng công cụ căn lề Align (Ctrl + F3) để căn nó vào chính giữa nền.
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Bước 5 
Chọn frame 80 của layer picture và nhấn phím F5 

Bước 6 
Thêm một layer mới với tên là line1. Chọn layer mới, sử dụng công cụ Rectangle Tool (R), Stroke color thiết lập không màu, Fill color chọn bất cứ màu nào mà bạn muốn rồi vẽ một hình chữ nhật với kích thước 10x20px. Sau đó, sử dụng Align Panel để đặt hình vừa vẽ theo vị trí middle right như hình dưới đây: 
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Bước 7 
Click vào frame 10 và nhấn F6. Sau đó chọn Free Transform Tool (Q) và làm theo hình vẽ dưới đây 
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Bước 8 
Click vào frame 20, nhấn F6 và cũng sử dụng công cụ Free Transform Tool để làm theo hình dưới 
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Bước 9 
Trở lại Frame1 và sau đó là frame 10, mở Properties Panel (Ctrl + F3), tại Tween chọn Shape 
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Bước 10 
Chọn layer line1 và chuyển đổi nó sang Mask bằng cách click chuột phải vào layer chọn Mask. 
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Bước 11 
Chọn layer line1, thêm một layer mới với tên là picture2 

Bước 12 
Chọn frame 60 của layer mới và nhấn F6. Sau đó nhấn Ctrl + R (Import to Stage) và Import một bức tranh khác. 

Bước 13 
Chọn frame 160 của layer picture2 và nhấn F5. 

Bước 14 
Thêm một layer mới với tên là line2 và lặp lại từ bước 6 -> bước 10 nhưng khác với line1, hoạt động của hình chữ nhật tại line2 sẽ bắt đầu từ phía trên trái. Hãy xem hình dưới. 
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Vậy là chúng ta đã hoàn thiện được 2 bức tranh đầu tiên trong banner rồi. Hãy lặp laij bước này nếu bạn muốn thêm nhiều hình nữa vào banner 

Bước 15 
Nếu bạn muốn đặt link vào các bức tranh thì việc đầu tiên cần làm là bạn chuyển đổi tranh sang dạng Movie Clip, rồi mở Action Script Panel (F9) ra và đưa vào đoạn mã sau (Chú ý thay URL website của bạn vào): 

on (release) { 
getURL ("http://www.quantrimang.com","_blank"); 
} 

Download file nguồn
1

